
by Gregg Hillmar | third edition
written for version 2011

Light Plot 
Deconstructed 
for Vectorworks Spotlight

by Gregg Hillmar | third edition
written for version 2011

Light Plot Deconstructed 
for Vectorworks Spotlight

Vectorworks Spotlight is a powerful 
addition to the Vectorworks family of design 
software. This tutorial manual is based on  
Gregg Hillmar’s successful Vectorworks Spotlight 
demonstration and training courses. Mr. Hillmar 
provides a short, accessible, and easy to follow 
look at Vectorworks Spotlight as an addition to the 
Vectorworks Manuals.

NVM.LPD-2011 v1.0  |  Cover imagery: Virginia Shakespeare Festival's 2008 production of 
"Taming of the Shrew";  courtesy of Gregg Hillmar.

About the Author | Gregg Hillmar is a scenic and lighting designer based in Richmond, VA.  
Mr. Hillmar’s work has been seen at  hundreds of Theatres, Dance and Opera Companies across the 
country. Non-theatre work includes designing galleries, lighting exhibits, and designing convention 
booths and stages. Mr. Hillmar has written about Vectorworks in many industry publications and has 
provided training for professional theatres, dance companies, businesses, educational institutions and 
individuals. He has done training seminars at USITT, LDI, SETC, and other industry organizations and 
conventions. Mr. Hillmar is an Associate Professor of Theatre Design and Technology at Randolph-
Macon College in Ashland, VA. He is a member of United Scenic Artists Local 829, the union for  
professional theatrical designers and artists, and can be visited on the web at www.hillmardesign.com.

SAMPLE



by Gregg Hillmar | third edition
written for version 2011

Light Plot 
Deconstructed 
for Vectorworks Spotlight

Vectorworks Spotlight Tutorial
Published by Nemetschek Vectorworks, Inc.

SAMPLE



Table of Contents

Introduction .....................................................................................1

Vectorworks ....................................................................................3

What’s New ....................................................................................5

In Ye Olde Days ..............................................................................9

Vectorworks Basics ......................................................................13
Opening a New Document ...............................................................................................1
Workspaces ....................................................................................................................13
Palettes ...........................................................................................................................15
Customizing Workspaces ...............................................................................................16

Preferences ..................................................................................21
Program Preferences .....................................................................................................21
Document Preferences ...................................................................................................24
Dimensions .....................................................................................................................24

Grids .............................................................................................27

Layers ...........................................................................................31

Design Layers ...............................................................................33
Name ..............................................................................................................................34
Scale ...............................................................................................................................34
Stacking Order ................................................................................................................34
Z and Delta Z ..................................................................................................................34
Opacity ...........................................................................................................................35
Renderworks Background ..............................................................................................35
Color ...............................................................................................................................35
Saved Views and Viewport Buttons ................................................................................35

Sheet Layers. ...............................................................................37
Page Setup .....................................................................................................................38

gregg hillmar
gregg@lightplotdeconstructed.com

© 2009, 2010, 2011 gregg hillmar
All rights reserved. No part of this book may be reproduced or transmitted in any form by any means, electronic or 
mechanical, including photocopying, recording, faxing, emailing, posting online, or by any information storage and 
retrieval system, without prior written permission of the publisher. Published in the U.S.A.

Vectorworks and Renderworks are registered trademarks of Nemetschek Vectorworks, Inc., in the U.S. and other  
countries. Windows is a registered trademark of Microsoft Corporation in the U.S. and other countries.
Macintosh is a trademark of Apple Computer, Inc., registered in the U.S. and other countries. Adobe, Acrobat, and 
Reader are registered trademarks of Adobe Systems in the U.S. and other countries.

The information in this book is distributed on an “as is” basis, without warranty. While every precaution has been 
taken in the preparation of this book, neither the author nor Nemetschek Vectorworks shall have any liability to any 
person or entity with respect to any loss or damage caused or alleged to be caused directly or indirectly by the infor-
mation contained in this book or by the computer software described in it.

For more Vectorworks training information or to purchase more copies of this book, please visit  
www.Vectorworks.net/training, or call us at (410) 290-5114.

SAMPLE

www.vectorworks.net/training


Classes .........................................................................................41

Palettes .........................................................................................45
Object Info Palette ..........................................................................................................45
Resource Browser Palette ..............................................................................................45
Palette Arrangement .......................................................................................................46

Saved View ...................................................................................49

Default Template ...........................................................................49

Vectorworks Spotlight  ..................................................................51
Architecture and Scenery ...............................................................................................51
Import Vectorworks File ..................................................................................................51
Import as Design Layer Viewport....................................................................................52
Import Image File ............................................................................................................54
Import PDF .....................................................................................................................56
Import DXF/DWG ...........................................................................................................56
3D Files ..........................................................................................................................58

Lighting Positions .........................................................................59  
Curved Lighting Positions ...............................................................................................63 
Truss Lighting Positions ..................................................................................................64

Focus Areas ..................................................................................67

Instrumentation .............................................................................71
Placing Instrumentation ..................................................................................................73
Instrument Insertion ........................................................................................................74
Beam and Field Display ..................................................................................................76
3D Instrumentation .........................................................................................................81
Photometer Tool..............................................................................................................81
Moving Lights .................................................................................................................82
MultiCircuit Instruments ..................................................................................................82
Position Awareness ........................................................................................................83

Label Legends ..............................................................................85

Accessories ..................................................................................89

Aligning Instruments .....................................................................93 

Twoferring .....................................................................................95

Vertical Positions and Instruments ...............................................97

Paperwork ..................................................................................101 

Lightwright Data Exchange .........................................................103 

Viewports ....................................................................................107

Printing .......................................................................................113

Third-Party Products ...................................................................115

Acknowledgments ......................................................................117

SAMPLE



 © 2010 Gregg Hillmar  |  Introduction 1iv Light Plot Deconstructed  |  © 2010 Gregg Hillmar

Introduction
Hi, I’m Gregg Hillmar. I’ve been working for many years as a scenic 
and lighting designer for theatre and other entertainment industries.  
In addition to a vigorous freelance career, I have taught at a variety  
of graduate and undergraduate institutions before happily settling at 
Randolph-Macon College in Ashland, Virginia. I’ve been using 
Nemetschek’s software package Vectorworks, and before that 
MiniCAD, since about 1992, and “full-time” since 1994 or so —based  
on the last hand-drafted show in my portfolio. I first experimented with 

drawing light plots and scenery in MacPaint, having bought my first Macintosh computer in 
late 1984. Subsequently I tried MacDraft, Canvas, and GenericCADD among others, but it 
was not until discovering MiniCAD that I felt giving up the pencil was in order.

Fast-forward several years, and I’m now asked to demonstrate Vectorworks, and particularly 
Vectorworks Spotlight by Nemetschek Vectorworks, Inc., the publishers of the Vectorworks 
software, at their booth at industry conventions including LDI, USITT, and SETC. I have also 
worked as a Vectorworks trainer and consultant for private corporations and public training 
seminars sponsored by theatrical organizations and educational institutions. I’ve done several 
Spotlight training sessions for the Nemetschek Vectorworks’s sales and tech support teams, 
including taking them into theatres to witness first hand the spaces, materials, and tools of our 
industry.

This book will take a quick look at how I use Vectorworks software to draft lighting plots.  
My way is not the only way. It’s not right or wrong. It’s just the way my practice and workflow 
have evolved over the 15 years I have been using Vectorworks. I’m reminded of Stanley 
McCandless’s famous (at least to lighting designers) book "A Method of Lighting the Stage" 
(Fourth Edition, 1958), which to many designers turned into the method of lighting the stage. 
There is no the implied here. My approach is not the end-all and be-all, but it works for me. 
This book reflects my approach. Feel free to adapt my ideas to your own approach.

My point of view is that theatrical drafting is about communication. It is somewhat free of the 
structures used in strictly architectural practice, but the end results are the same. We need to 
communicate clearly and concisely with those we work with. They need to be able to under-
stand in an instant what they are looking at and be able to use that information. Choices we 
make in line weight, dashes, hatches, symbols, and all of the other graphics are the language 
in which we communicate. Page layout and choices of what is on each plate in a set of 
drawings puts that language into context. The composition of the page refines that context. 
We can turn out really beautiful drawings, full of style and grace, but unless the shop can read 
them and instantly understand what is being communicated, the drawings are just so much 
paper waiting to be recycled. 
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This book will certainly reflect my drafting style, as taught to me primarily by William H. Lockey 
(University of Richmond), and John Rothgeb and David Nancarrow (University of Texas 
Austin). My style has been further refined by many years of drafting scenery and lighting for 
theatre, and working with myriad theatre artists who also draft. From them, I’ve borrowed what 
I like, and vowed to never do what I don’t like. Note that this is not a book about drafting style. 
There are better books out there for that; some are CAD-specific, but the ones I like are not.

It is also worth noting that the output this book is geared towards is a 2D plot and paperwork. 
While we will delve into the 3D world of Vectorworks as it assists us in creating the plot, that 
plot, printed, is our final goal. And a plot, printed, is a 2D representation.

3D computer modeling, and lighting models, is perhaps the subject of another book.

Finally, there is not any discussion of design choices here; you’re on your own for those.  
We need to remember that the output that this book is geared toward (the plot) is not art,  
but communication. Art happens in the theatre. Perhaps that is best described, even all these 
years later, by Robert Edmond Jones in “Light and Shadow in the Theatre,” Chapter 6 of  
"The Dramatic Imagination" (1941):

We handle our spotlights and gelatines and dimmers [and CAD software] in the theatre with 
the same delight and the same sense of mastery with which we drive a high-powered 
automobile or pilot an aeroplane. But at rare moments, in the long quiet hours of light- 
rehearsals, a strange thing happens. We are overcome by a realization of the livingness of 
light. As we gradually bring a scene out of the shadows, sending long rays slanting across a 
column, touching an outline with color, animating the scene moment by moment until it seems 
to breathe, our work becomes an incantation. We feel the presence of elemental energies 
(Jones, p. 113).

While we are studying to perfect ourselves in the use of the intricate mechanism of stage 
lighting we are learning to transcend it. Slowly, slowly, we begin to see lighting in the theatre, 
not only as an exciting craft but as an art, at once visionary and exact, subtle, powerful, 
infinitely difficult to learn. We begin to see that a drama is not an engine, running at full speed 
from the overture to the final curtain, but a living organism. And we see light as a part of that 
livingness (Jones, p. 114).

And, “Lucidity, penetration, awareness, discovery, inwardness, wonder… These are the 
qualities we should try to achieve in our lighting.” (Jones, p. 121).

And perhaps best, “Does this mean that we are to carry images of poetry and vision and  
high passion in our minds while we are shouting out orders to electricians on ladders in 
light-rehearsals? Yes. This is what it means.” (Jones, p. 128).

Vectorworks
According to the Nemetschek Vectorworks website:

Nemetschek Vectorworks, Inc., is a wholly owned subsidiary of European software giant 
Nemetschek AG. A global leader in design technologies, Nemetschek Vectorworks has been 
developing computer-aided design (CAD) software for the architecture, engineering, and 
construction, entertainment, landscape design, and manufacturing fields since 1985. The 
Vectorworks® product line is one of the world’s best-selling cross-platform CAD applications 
and has won many industry awards. The Nemetschek Vectorworks family of software includes 
Vectorworks Designer, Architect, Landmark, Spotlight, Fundamentals, and Renderworks® 
(www.nemetschek.net/company/history.php, 08/25/2010).

MiniCAD, the predecessor of Vectorworks, was originally written by Richard Diehl, legend  
has it at his kitchen table, and was first published by Diehl Graphsoft in 1985. Initially a 
Macintosh-only application, MiniCAD 6 became cross-platform in 1996. MiniCAD 7 updated to 
Vectorworks 8 in 1999. Nemetschek AG purchased Diehl Graphsoft in 2000 and created 
Nemetschek North America, Inc. In 2001, Vectorworks added the Spotlight package as an 
add-on, along with several other “vertical” products. Vectorworks is currently configured as a 
Fundamentals level with Spotlight, Renderworks, Architect, Landmark, and Machine Design 
as separate products. The Designer package includes all of the add-ons.

Nemetschek North America changed its name in 2010 to Nemetschek Vectorworks, Inc.. “We 
are best known for our flagship Vectorworks® product line, and incorporating this brand into 
our company name better reflects our focus,” said CEO Sean Flaherty. “Our top three markets 
are Japan, USA, and Germany, and a company name that is product-based rather than 
geography-based indicates our mission more clearly while also clarifying our position within 
the Nemetschek group” (www.nemetschek.net/news/pressreleases/2010/nemetschek-north-
america-changes-name-to-nemetschek-vectorworks.php, 08/25/2010).

Early in its history, Diehl Graphsoft identified theatrical design as a viable market and is the 
only major publisher of CAD software that I am aware of who intentially hired developers  
with theatre backgrounds to support theatrical applications of that software. In the mid-1990s, 
Diehl Graphsoft hired Frank Brault to develop some theatre-specific macros and symbols. 
Frank Brault came from a professional theatre and dance background with lighting  
experience. The Lighting Toolkit package grew out of his initial work. Sometime thereafter,  
Kevin Moore and Kevin Linzey were hired, first as student interns and then full-time. Kevin 
Moore took over Spotlight development. Both Kevins had theatre backgrounds, and both  
have worked for me on various shows and events. Kevin Moore eventually left Nemetschek  
to return to event, production, and management work, and Kevin Linzey moved into the lead 
Spotlight developer role. Kevin Linzey does still occasionally work in theatres while keeping 
his “day job” with Nemetschek Vectorworks. The people working on, and with, Spotlight know 
theatre as well as software development. The ongoing commitment to theatre on the corpo-
rate level and the individual level is a huge advantage for all of us. 
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As noted earlier, MiniCAD was developed initially for the Macintosh. More than a decade after 
the first PC release, though, Vectorworks remains a cross-platform program. It works equally 
well on a PC as it does on a comparable Macintosh. There are no real programming differ-
ences. Files created on one can be opened and used on the other and traded back and forth 
with no issues. There are some minor differences, mainly visual, created by how the two 
operating systems work. As an example, in the PC world, palettes can be floating or “docked” 
into the program’s window. On the Macintosh, the drawing window and all the palettes are 
always separate floating windows. I should mention that all screenshots used here are from 
the Macintosh version.

What’s New
The first edition of "Light Plot Deconstructed" came out during the Vectorworks 2009 “model 
year.” I stated then that the concepts and general usage of the book were not specific to one 
version of Vectorworks. I would still say that with some modification for changes in workspac-
es and tools, this book should work fine with many versions of Vectorworks. This book is more 
about approach and is not a step-by-step tutorial.

That said, I have upgraded this edition to reflect Vectorworks 2011. There were many 
important improvements in Vectorworks 2010, and Vectorworks 2011 promises to be an 
absolutely must-have upgrade. Vectorworks Spotlight has benefited from all of those improve-
ments. Vectorworks 2010 introduced some new tools; prime among them are some very nice 
video projection tools initially developed by C. Andrew Dunning of Landru Design, improved 
and incorporated into Spotlight. Improvements in event planning and staging tools will have 
obvious implications for those designing conventions or other events. Some interface 
improvements in Vectorworks 2010 make drawing the plot easier. For example, when a 
lighting instrument is made active in the Resource Manager, the Instrument Insertion tool is 
selected automatically. In past versions, the Symbol Insertion tool was selected automatically 
and we had to remember to select the Instrument Insertion tool. Likewise, in Vectorworks 
2011, select an accessory and the Accessory Insertion tool becomes the active tool.  
Vectorworks 2011 has added several improvements to tools used every day in Spotlight. The 
Ganging Tool and the Auto-Position Sensing have received some attention and have new 
preferences to better customize the information on the plot. Focus Points have better options 
and enhanced graphics. Other improvements enhance 3D functionality; for example, 3D 
lighting fixtures now rotate to point to the assigned Focus Point while the 2D representation 
stays as set by the user.

For lighting designers, the Automatic Data Exchange between Vectorworks Spotlight and 
Lightwright 5 has proven to be a great feature. There is a new section later in the book 
devoted to working with Lightwright. Lightwright 5 was rewritten from the ground up, and is a 
huge improvement in handling information in our field. 

Never mentioned in the first edition of "Light Plot Deconstructed" is that Vectorworks 2009 
experienced a similar transformation. The core code that controls the 3D aspects of  
Vectorworks was completely replaced. One of the concepts I stress is the outcome that this 
book is devoted to is a 2D drawing— the plot, printed. Starting with Vectorworks 2009 and 
continuing through Vectorworks 2011, the way that 2D information is handled is changing. 
While most of the changes will have little impact on “the plot,” the overall way Vectorworks 
now deals with 2D information is worth exploring.

The simplest way to explain this is that 2D geometry and information can now interact with 3D 
space. In earlier versions of Vectorworks, I could draw a rectangle using the 2D rectangle tool. 
I could then change to any 3D view, front, front-left isometric, rear, whatever, and the rectangle 
“hovered” in front of the view— parallel, if you will, to the screen. 

SAMPLE



 © 2010 Gregg Hillmar  |  What's New 76 Light Plot Deconstructed  |  © 2010 Gregg Hillmar

Starting in Vectorworks 2010, I can define different ways to deal with those 2D objects. 2D 
objects can be either in the “Screen Plane” in that they will always be “parallel” to the screen 
regardless of the view “behind” them, or they can be in the “Layer Plane,” which means that 
they are always in the X,Y plane with no Z presence at all. Layer Plane objects display in 3D 
views as if they are laying “on the floor.” This is very handy for seeing 2D floorplans while in 
3D views, as with the 2D floorplan seen in a Left Isometric view in Figure 1. 2D objects drawn 
in the Top/Plan View will default to Layer Plane, while 2D objects drawn in any other standard 
view will default to Screen Plane. If a Working Plane is defined, 2D objects can be drawn on 
that working plane, and will respond as if on a layer plane, meaning that 2D details can be 
drawn over 3D objects, and will keep their relationship to that object in any 3D view. This is 
great for elevations and detail drawings.

In previous versions of Vectorworks, text blocks were not very text-like. Entering a text block 
to edit removed it from any connection to the rest of the drawing, and such things as line 
breaks changed from editing mode to what was seen on the drawing. In Vectorworks 2010, 
text, like other 2D objects, could exist as a screen plane object or as a layer plane object.  
In a 3D view, however, the text showed only as the bounding rectangle. Vectorworks 2011 
improves text editing and gives text blocks a real place in the 3D world. Text set as a layer 
plane object is now still text in the 3D world. Vectorworks 2011 now includes support for text 
styles that will remember text attributes and can apply them to any block of text.

Dimensions have some new properties, especially when dealing with 2D and some 3D 
objects. In Vectorworks 2009, a 2D rectangle could be dimensioned with the Dimension tool, 
and the dimensions would be “associated.” If the size of the rectangle was changed, the 
dimensions would also change. Vectorworks 2010 carried this relationship a step further.  
I can double-click on the dimension itself, type in the new dimension, and both the dimension 
and the rectangle will change to match the new dimension. 

Walls and other 3D objects have seen some improvements as well, and snaps in 3D views are 
much improved. The Unified View command makes working in 3D space much more intuitive, 
and the ease of Working Plane alignment really helps drawing in 3D space. Indeed, Vector-
works 2011 has added “push and pull” methodology to working with 3D surfaces.

Of special interest is that Vectorworks 2011 has new rendering technology. Rendering is now 
based on the very powerful Cinema 4D rendering engine from MAXON. It is completely 
multi-threaded, and the new technology is much faster, easier to use, and provides better 
quality than the previous rendering engine.

Since almost everything referenced in this book deals with the plot as a 2D document, and 
most tools are used in Top/Plan view (the “2D” view) when creating the plot, many of these 
changes are not immediately noticeable. However, the way lighting designers use the 3D 
aspects available in Vectorworks is beginning to change as the ease of working in 3D 
improves. Scenic designers of course have much more use for many of the 3D aspects, and 
as we receive files from them, we’ll be able to put some of the 3D technology to use.

Visit the Nemetschek Vectorworks web site for a complete overview of the changes in 
Vectorworks 2010 and 2011.

In this book, illustrations, menu commands, and tool references have been updated to reflect 
Vectorworks 2011. Most of the tools and techniques I use are available in Spotlight and 
Renderworks added to the Fundamentals, though my copy of the software is a full Designer 
version. I also use several third-party scripts and macros, which are now listed at the back of 
this book. Use of these third party add-ons will be mentioned in this book, but most techniques 
discussed here will be available to all Vectorworks Spotlight users with Renderworks.

Fig. 1
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In Ye Olde Days…
In “Ye Olde Days,” using a drafting machine, a parallel, or a T-square, we carefully squared a 
piece of vellum onto our drafting boards, taped it into place, and grabbing our lead holder or 
mechanical drafting pencil, began drafting…

Ah, but what and where? 

While designing scenery, most often I’d start by squaring a bluelined print of the theatre 
floorplan to the drafting board, then lay a piece of vellum or, if still thinking, a piece of 
butterpaper over that. Butterpaper was much cheaper than vellum and so easily thrown away. 
Based on quick thumbnail sketches, rough sketchy workings of the floorplan would emerge. 
Another piece of butterpaper taped down; copy up the good stuff and keep thinking on paper. 
Then, slap the vellum on top of the stack on the drafting board and trace up the architecture 
and the rough set. Add the title block, and it’s done.

Not quite. The floorplan is pulled off the board, another piece of vellum squared down, and 
elevations are started. Hmmm. Does that door look better if it is off center in the wall? Does 
that reflect the character of the inhabitants better? Sure, let’s change it! So finish roughing in 
the elevations on that one page. Pull it up, and lay the floorplan back on the drafting board. 
Pull out the electric eraser, and move the door on the floorplan. Pull up the floorplan; lay down 
another sheet, and work those elevations. Hmmm. What can the audience see through that 
window? What can audience members in the balcony see? Pull up the elevation, lay down a 
blueline of the Center Line section of the theatre and a piece of vellum, and rough in a section 
of the set. If we move that wall 6" further downstage, the masking can work with the existing 
linesets. Finish roughing it in, pull the section off the board, put the floorplan back down, dig 
out the eraser, and move the wall on the floorplan. Pull that up, tape the elevation back down, 
and…

Well, only sometimes was the process quite so convoluted, but that was the thought process.

And deciding what each plate looks like was important. Plates of drafting are methods of 
communication, and composition of the plates was important in that communication. Leading 
the eye to the important information is part of the job of the composition. Which elevations 
would fit on which plate with which other elevation? Or with which detail? And where on the 
plate was best? Balance the tendency to read from top left with the reality of not flipping a 
whole set of drawings, stapled, all the way open. Top right becomes the first seen, though the 
placement of the title block may influence that. So, just like in any “artistic” composition, I use 
other elements to control emphasis and visual flow. Decisions about what would be on each 
plate needed to be made at the beginning of the process, and any changes in those decisions 
meant tedious redrafting of the entire plate(s). 

Drawing a light plot was a little less complicated. I usually started with the floorplan of the set 
and the architecture of the theatre. In a multi-set show, the floorplans might be on different 
sheets, so again I would have multiple layers of vellum on the drafting board. The section 
drawing and a composite front elevation of the set were developed and kept close at hand to 
check the angles at which light was hitting the performer.
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Lay down a fresh sheet of vellum, and draw indications of the areas to be lit. Using a drafting 
machine, squares are faster to draw than circles or ovals, so I marked my areas as squares. 
Of course, I know that light doesn’t naturally fall into nice neat squares, nor do I usually want it 
to, but it is a convenient visual representation. Next I might draw the existing lighting positions. 
Then add a fresh sheet of vellum and start drawing instrumentation. Use the drafting machine 
to mark the horizontal angle from the area to the position, check the section to make sure the 
vertical angle works. Mathematically calculate the distance of the throw. Check the size of the 
beam for the preferred instrument type at that throw, then get out the lighting template and 
draw the outline of the desired instrument. Add notes about color, channel, purpose, and so 
on. Move to the next area. Wash. Rinse. Repeat. But wait! In order to get the right angles, 
these two instruments must hang in the same place. One has to move. And in order to keep 
instruments 18" apart—a long-standing industry “standard”—that means four other instru-
ments next to this one need to move also. Dig out the electric eraser, erase, and redraw. 
Wash. Rinse. Repeat.

Once the rough plot is finished, I’d lay down yet another sheet of vellum and trace up all of the 
information that I wanted to appear on the plot. One of the major ways I control composition 
and visual importance in drafting is use of line weight. Line weight is achieved primarily 
through the darkness and the thickness of a line. In Ye Olde Days, this was achieved in 
several ways.

Graphite lead was used in “lead holders.” Lead came in different hardnesses. Softer leads put 
more graphite on the page and were generally considered “darker” or “heavier” than harder 
leads. Harder leads were more suited to thinner lines, while softer leads worked better for 
thicker lines.

Sharpness of the lead created different line thicknesses. The lead was “twirled” in a lead 
sharpener to a razor sharp point, or a slightly blunted end. The resulting lead dust was 
removed by sticking the now-sharp lead into a “swab” of cotton, or of Styrofoam, or—my 
personal favorite, the end of a roll of toilet paper. The sequence of drawing a few lines, 
sharpening, and dusting created its own rhythm and Zen-like concentration. Sharpening stops 
were perfect times to contemplate the look of the object being drawn and make decisions 
about the next few lines.

Control of the lead holder was also critical. The lead had to be perpendicular to the page at all 
times or the point would be “wedged,” and the resulting line would not be a consistent width. 
Drafting involved a subtle twist of the lead holder as lines were drawn to even the wear on  
the point.

I had one professor tell me that another part of the line weight equation was the indention the 
pencil made in the paper. So control of the depth of the line was another method of line weight 
control when bluelining was the method of distribution. It took careful control to push the lead 
deep enough into the vellum to make a good trough, but not deep enough to rip through  
the vellum. 

Mechanical drafting pencils were also available. Similar to mechanical pencils available 
everywhere, the thickness of the line was controlled by the thickness of the lead. Standards 
available included 0.03-mm, 0.05-mm, 0.07-mm, 0.09-mm, and so on, and were placed in 
pencils sized to match. Such pencils made for drafting tended to be much more precise and 
well crafted than those available at the local store and had price tags to match. Leads of all 
sizes were available in different hardnesses, again; harder leads worked better for thinner 
lines and softer leads for thicker lines. Combinations, though, gave the drafter an almost 
infinite variety. Twirling the pencil was still necessary to keep an even line.

I often used ink drafting pens in addition to pencils. With ink, line weight was mainly a function 
of the thickness of the line. Pens came in different thicknesses just like mechanical pencils 
mentioned earlier, and the ink laid out from the pen—after some practice—reflected that 
thickness.

One advantage to using pens was that ink did not erase easily. Therefore, all the preliminary 
work could be done with graphite, not paying any attention to lineweight or crisp stops to lines. 
Once the object was “finished,” it could be inked neatly with proper line weight. The rough-in 
of graphite could be erased, leaving only the ink. On the other hand, one disadvantage to 
using pens was that ink did not erase easily…

The lighting instruments and their hanging positions should have prime focus, so the set and 
so forth might be drawn in lighter-weight lines. Architecture is copied up, then the lights 
themselves redrawn with the relevant information. For example, while roughing in the plot, 
having the purpose of each light noted is very convenient when shuffling lights around. Having 
the purpose of each light on the final plot is not useful information, so that would not get traced 
up. On the rough plot, channel designations might be quickly noted, while on the final plot I 
always put them inside a circle connected to each light. Lighting positions that on the rough 
plot are drawn as a continuous line are “broken” by instruments drawn on that position in the 
final version. Notes about trim heights are added, having been decided by working out 
sightlines and angles from the section drawing. Depending on the size of the drafting board, 
that may mean dislodging the plot-in-process to tape down and draw the section. Light plot 
finished, add the title block, and off it goes for distribution.

Distribution of drawings was mainly done via “bluelining” an original drawing done on vellum. 
The original was fed through a diazo blueline machine with a piece of light-sensitive paper 
under it. The ultraviolet lamp in the machine would cast the shadow of the original on the 
blueline paper. The original exited the machine, while the paper then revolved through an 
ammonia-based developing process. Anything dark on the original came through as blue on 
the finished print. Subtle variations and shades translated; but not always quite as subtly as 
the original pencil.

If I needed ten copies of the drawings, I had to manually run the original with a piece of blue- 
line paper through the blueline machine ten times. Recently I did a scenic design where the 
set of drawings had 24 sheets. In Ye Olde Days, that meant 240 trips to the blueline machine.
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Luckily, most light plots are not so many sheets. The plot, printed, is ready to be distributed to 
the Master Electrician and anyone else who needs it.

But wait: there is still the paperwork to finish. Information about each and every light is noted 
—by hand In Ye Olde Days on blank forms drawn and reproduced for just such purposes. 
Photocopy those for all involved if there was a photocopy machine available. Hope that there 
are no changes “on the fly,” which necessitate changing multiple sheets of paper—by hand— 
for multiple people. John McKernon, author of Lightwright, tells the story of watching all of his 
tour mates go off to the beach while he remained in the hotel updating the plot and paper-
work…again.

It all was a rather time- and thought-consuming process. And it was not always fun.

I was in graduate school in the mid-80s when a touring dance company came through the 
Performing Arts Center. I remember vividly a discussion with the Production Manager, who 
was traveling with one of the very first PCs. He could save and update his paperwork as 
quickly as he could type, and then print out new versions right then and there. The implica-
tions were obvious, and it was not long after that designers began working on preparing and 
presenting visual information on computers as well. Fast-forward many years, and we now do 
what is basically the same process as outlined earlier, but with much less trauma and stress, 
not to mention much less drafting tape.

Still, the way I approach drafting a light plot in Vectorworks is very similar to the way we used 
to approach drafting by hand. Design Layers in Vectorworks are our sheets of vellum; we are 
always drawing on a virtual sheet of vellum. At the end of the process, we will “copy up” what 
we want to print to a Sheet Layer, placing elements there for visual communication. Line 
weight still gives us as much information as always, so it too gets “reproduced” in our digital 
approach. Communication is still the main point of drafting a light plot. 

Vectorworks Basics

Opening a New Document

I’ll assume you have knowledge of your particular computer and operating system (OS). I’ll 
also assume you have installed Vectorworks on your computer and have a working knowledge 
of “the basics.” I would suggest working through the free "Getting Started Guide" to learn  
those basics.

Most of the references made in this book are Macintosh-based since that is what I use, but 
“click on the selection tool,” or “in the Modify menu” should be the same regardless. I’ll note 
that there is a Macintosh/Windows dictionary in the Vectorworks manual that lists exact key 
and menu commands cross-referenced for each platform.

When Vectorworks is started, I have my preferences set so that no document is opened. 
Selecting New from the File menu opens a dialog box asking what to do. Create blank 
document does just that, creating a “virgin” untitled document. Under Use document 
template, choices can be made from files provided with Vectorworks. In addition, a default 
template can be created and saved to be used at any time. The advantage of this is that users 
can set up their own default to look like anything they want; select scale, paper size, default 
layer and class assignments, default symbols, textures, and Vectorworks and document 
preferences, and then save that setup as the default. Every time that document is opened, 
that setup will be used. Over the next few pages, I’ll talk about my preferred setup, and then 
I’ll talk about saving the default file.

When I open a new file, I see the layout shown in Figure 2. This will be the starting point to 
creating my default file.

Workspaces
Workspaces define how the menu commands, tools, and palettes are organized and define 
the “shortcut keys;” keystrokes that evoke particular tools or commands. Vectorworks ships 
with a series of predefined workspaces that can be selected from the Tools>Workspaces 
menu. Exactly which ones are available will depend on which modules of Vectorworks are 
installed. I’ll assume that the Spotlight module is installed, so that is the workspace to start 
with. The image in Figure 2 shows the Spotlight workspace.

Vectorworks does allow the tools, commands, and menus to be customized to best suit 
individual working habits and to add additional tools or commands to the workspace. I, for 
example, move often from my laptop by itself to my laptop with an additional monitor and 
therefore have two main workspaces customized and saved. Right now, using Vectorworks 
2011, one of my workspaces is called g11_1scr, and the other is called g11_2scr. Both have 
custom menus, custom tool palettes, and saved scripts—the difference being where the 
palettes are located on the screen. When using two screens, I keep important palettes open 
and visible on the right monitor while the drawing area and basic tools fill the space on the left 
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monitor. That layout is saved as g11_2scr. 
On the road when using just the laptop, I 
switch to g11_1scr, where the palettes are 
collapsed up on top of the Drawing Window 
bar. On the Macintosh, palettes cannot dock 
into the drawing window as in the PC world; 
each remains a separate floating window. 
But they can be collapsed and positioned as 
out of the way as possible.

Palettes
Tools used in Vectorworks are organized in 
palettes. The basic 2D tools are in the Basic 
palette. Other tools are arranged under tabs 
in the Tool Set palette. By clicking on the 
tab, tools in that category are displayed.

All of the tool palettes are “tear-offs” in that 
clicking on the tab bar of the palette, one 
can drag the tools anywhere on the screen 
so that they are not just in the Tool Set 
palette. Moving a Tool palette closer to 
where the actual work is being done saves 
a lot of mousing back and forth. Using 
shortcut keys will also save mousing—a 
keystroke can select a tool or execute a 
menu command. Learning the shortcut keys 
is a very good way to save time and energy 
while drafting. The key combination can be 
seen in the pop-up tool tips. 

On the bottom of palettes is a pull-down 
menu that lets me specify whether tools are 
displayed as colored icons, by name, or by 
both icon and name.

Fig. 2

Palettes can be made visible or invisible via key commands or via the Palettes menu. On the 
Macintosh, they can be collapsed by double-clicking in the title bar. In Windows, the palettes 
can be free-floating windows, docked into the main Vectorworks window, or hidden using the 
Auto Hide feature.

Palettes can be manually reorganized to fit in any workflow. In addition to the Basic and Tool 
Set palettes, always on the left of my main screen, the palettes I use most often are the 
Navigation palette, the Resource Browser, the Attributes palette, and the Object Info palette 
(referred to as the OIP). I keep them open always, collapsed at the top of the screen when 
working with one screen, or open on the second screen to the right of the Drawing Window 
when using two screens. Vectorworks will remember the last location of all palettes and  
 put them there when reopened. That is the first step in defining how to best work with 
Vectorworks. The second step is to customize the palettes and menus. 
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Customizing Workspaces
The custom scripts and tools that I use regularly have been added to an individualized tool 
palette called “greggs” and to a menu called “g11_2scr” (on my two-screen workspace) named 
so I know at a glance what workspace is active. In addition, I’ve gathered menu commands 
relating to Spotlight into one menu. Prior to 2011, Vectorworks shipped with these menu 
commands organized by function in many other menus. I’ve also moved the new Event 
Planning menu commands under my Spotlight menu as well.

In Vectorworks 2011, the Spotlight Workspace already has all of the Spotlight commands in a 
separate menu. I’ll still want to move some other menu commands around, as well as add 
some custom scripts. 

Scripts can be written by anybody and included in menus or as custom tools. Vectorworks 
includes a scripting language that can accomplish many things. Not a coding guru? Many 
repetitive commands can be “memorized” and saved as a simple script to be used again and 
again. The Custom Modification… and Custom Selection Tools include this option in the 
dialog box itself.

There are also freeware and shareware commands and tools readily available from other 
users. To find many of them, start with the community page at the Nemetschek web site, www.
nemetschek.net/community/index.php. There are several theatre lighting specific scripts and 
tools available there and elsewhere. AutoPlot, for example, is just such a set of scripts. It is 
available via www.autoplotvw.com. I never leave home without it. I’ve mentioned the video 
screen tool introduced in Vectorworks Spotlight 2010. It originated as a third-party tool set, 
and is still available for earlier versions of Vectorworks. The same author has several other 
tools, including a great curtain tool and a new LED array tool. The link to Landru Design is  
www.landrudesign.com. While at the community page, also visit the Mailing Lists link, where 
there is a link to the Vectorworks Theatre Mailing List. Here you will find discussion of 
Vectorworks as used in theatre. Many questions are asked and answered here, including 
scripting theatre-specific macros. A member of that list working in a nontraditional space 
recently asked about numbering instruments in a clockwise fashion. Sam Jones, author of the 
AutoPlot macros, had a script written and posted within a day or so of the request. There is a 
wealth of information here! 

I’ve included information about several third-party tools, symbols, and scripts at the end of this 
book. I use them all; some on every plot, and some as needed depending on the complexity of 
the project.

Once acquired or made and saved, any of these scripts and tools can be added to a custom 
workspace. I’ll also rearrange the existing commands and tools to best suit my workflow. To do 
so in Vectorworks, I select Tool>Workspaces>Workspace Editor.

Initially, I’ll work on a copy of the existing workspace, which as suggested before, should be 
the Spotlight workspace. I’ll choose to Edit a copy of the current workspace.

I’ll give the workspace a new name. My workspace name tells me which version of  
Vectorworks I made it for, and how many screens.

The Workspace Editor opens, first showing the menus editor tab. To create a new menu, drag 
the New Menu from the left of the box to the list of menus on the right. Select the new menu 
and rename it as desired. In Figure 3, I’ve named a new menu gah1scr. Then I can click and 
drag available commands from the left panel to the right under a new menu or an existing 
menu. These do include existing Vectorworks commands as well as third-party commands, 
and the Workspace Editor now shows all of the new menu commands added in the last three 
versions of Vectorworks.

Fig. 3
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